Microsoft Project 2019
Step by Step

Cindy Lewis
Carl Chatfield
Timothy Johnson
Contents at a Glance

Part 1: Get started with Microsoft Project ............................................. 1
  1: Project, project management, and you .............................................. 3
  2: Take a guided tour ........................................................................ 11

Part 2: Simple scheduling basics ................................................................. 35
  3: Start a new plan ........................................................................... 37
  4: Build a task list ............................................................................ 49
  5: Set up resources ........................................................................... 79
  6: Assign resources to tasks .............................................................. 99
  7: Format and share your plan .......................................................... 125
  8: Track progress: Basic techniques ................................................. 153

Part 3: Advanced scheduling techniques ..................................................... 173
  9: Fine-tune task scheduling ............................................................. 175
  10: Fine-tune task details ................................................................ 209
  11: Fine-tune resource and assignment details .................................... 227
  12: Fine-tune the Project plan ............................................................ 255
  13: Organize plan details .................................................................. 279
  14: Track progress: Detailed techniques ........................................... 311
  15: View and report project status ..................................................... 333

Part 4: In-depth and special subjects ............................................................. 355
  16: Format and print views: In-depth techniques .................................. 357
  17: Format reports: In-depth techniques ............................................ 387
  18: Customize Project ....................................................................... 403
  19: Share information with other programs ....................................... 423
  20: Consolidate projects and resources .............................................. 447
  21: Use Agile project management with Project ................................. 469
Part 5: Appendixes .......................................................... 503

A: A short course in project management ............................. 505
B: Develop your project management skills ......................... 515
C: Collaborate: Project, SharePoint, and PWA ..................... 519
D: Use this book in a classroom ........................................ 535

Glossary ........................................................................ 539
Index ........................................................................... 547
About the authors ......................................................... 567
Contents

Author Acknowledgments .............................................. xvii

Introduction ............................................................ xix
  Who this book is for ..................................................... xix
  The Step by Step approach ............................................ xix
  Download the practice files .......................................... xx
  E-book edition .......................................................... xxii
  Adapt procedure steps ............................................... xxii
  How to get support & provide feedback .......................... xxiii
    Errata & book support ............................................... xxiii
    Stay in touch ....................................................... xxiv

Part 1: Get started with Microsoft Project

1 Project, project management, and you .......................... 3
  Practice files .......................................................... 3
  Meet the Project program .......................................... 3
  Meet the Project family ............................................. 4
  See the new features in Project 2019 ............................ 5
  Review features in earlier versions ............................... 6
    New in Project 2016 ................................................. 6
    New in Project 2013 ............................................... 7
    New in Project 2010 .............................................. 8
  Take a project manager’s perspective ............................ 9
  Let’s get started! .................................................... 10
Part 2: Simple scheduling basics

3 Start a new plan ..................................................37
Practice files .......................................................37
Create a new plan and set its start date .........................37
Set nonworking days in the project calendar ..................39
Enter the plan title and other properties ......................43
Skills review .......................................................44
Practice tasks ......................................................45
Create a new plan and set its start date .........................45
Set nonworking days in the project calendar ..................45
Enter the plan title and other properties ......................46

4 Build a task list ..................................................49
Practice files .......................................................49
Create tasks .......................................................49
Switch task scheduling from manual to automatic ..........51
### 6 Assign resources to tasks

- Practice files ................................................. 99
- Assign work resources to tasks ......................... 100
- Control work when adding or removing resource assignments ............ 105
- Assign cost resources to tasks .......................... 111
- Check the plan after assigning resources ............... 112
- Skills review .................................................. 116
- Practice tasks .................................................. 117
  - Assign work resources to tasks ....................... 117
  - Control work when adding or removing resource assignments .......... 120
  - Assign cost resources to tasks ....................... 121
  - Check the plan after assigning resources ............. 122

### 7 Format and share your plan ........................................... 125

- Practice files .................................................. 125
- Customize a Gantt chart view .............................. 126
- Add tasks to a Timeline view ............................. 133
- Customize reports ............................................ 137
- Copy views and reports ................................... 140
- Print views and reports ................................... 142
- Skills review .................................................. 145
- Practice tasks .................................................. 146
  - Customize a Gantt chart view ......................... 146
  - Add tasks to a Timeline view ......................... 148
  - Customize reports ..................................... 149
  - Copy views and reports ................................ 150
  - Print views and reports ................................ 151

### 8 Track progress: Basic techniques ................................. 153

- Practice files .................................................. 153
- Understand progress tracking ............................ 154
Save a baseline of your plan ..................................................... 155
Track a plan as scheduled ...................................................... 158
Enter a task's completion percentage ....................................... 160
Enter actual values for tasks ................................................... 163
Skills review ........................................................................ 167
Practice tasks ....................................................................... 168
  Save a baseline of your plan ................................................ 168
  Track a plan as scheduled .................................................... 169
  Enter a task's completion percentage .................................... 169
  Enter actual values for tasks ............................................... 170

Part 3: Advanced scheduling techniques

Fine-tune task scheduling ......................................................... 175
Practice files ........................................................................ 175
See task relationships by using Task Path ................................. 176
Adjust task link relationships .................................................. 179
Control task scheduling by using constraints ............................. 182
Interrupt work on a task ........................................................ 188
Adjust working time for individual tasks ................................ 190
Control task scheduling by using task types ............................. 193
See task schedule details by using the Task Inspector ............... 199
Skills review ........................................................................ 201
Practice tasks ....................................................................... 202
  See task relationships by using Task Path ............................. 202
  Adjust task link relationships .............................................. 203
  Control task scheduling by using constraints ......................... 204
  Interrupt work on a task ..................................................... 204
  Adjust working time for individual tasks ............................... 205
  Control task scheduling by using task types ......................... 206
  See task schedule details by using the Task Inspector ............ 207
### Fine-tune task details

- Practice files ................................................. 209
- Enter deadline dates ........................................ 209
- Enter fixed costs ............................................. 212
- Create a recurring task ....................................... 213
- View the plan’s critical path .................................. 217
- Schedule summary tasks manually .......................... 219
- Skills review .................................................... 222
- Practice tasks .................................................. 223
  - Enter deadline dates ....................................... 223
  - Enter fixed costs ........................................... 223
  - Create a recurring task ..................................... 224
  - View the plan’s critical path ................................. 225
  - Schedule summary tasks manually ......................... 226

### Fine-tune resource and assignment details

- Practice files .................................................. 227
- Change resource availability over multiple date ranges ............................................. 228
- Work with multiple resource pay rates ................................................................. 230
- Change resource pay rates over different date ranges .......................................... 233
- Delay the start of assignments ........................................ 235
- Apply contours to assignments ........................................ 236
- Create and assign material resources ........................................ 239
- View resource capacity ........................................ 242
- Adjust assignments in the Team Planner view (Project Professional only) ............... 244
- Skills review .................................................... 247
- Practice tasks .................................................. 248
  - Change resource availability over multiple date ranges ........................................ 248
  - Work with multiple resource pay rates ................................................................. 249
  - Change resource pay rates over different date ranges ........................................ 250
  - Delay the start of assignments ........................................ 251
Apply contours to assignments ........................................... 251
Create and assign material resources ................................. 252
View resource capacity ..................................................... 253
Adjust assignments in the Team Planner view
(Project Professional only) .............................................. 254

<table>
<thead>
<tr>
<th>12</th>
<th>Fine-tune the Project plan ........................................ 255</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Practice files .................................................. 255</td>
</tr>
<tr>
<td></td>
<td>Examine resource allocations over time ....................... 255</td>
</tr>
<tr>
<td></td>
<td>Resolve resource overallocations manually ................... 260</td>
</tr>
<tr>
<td></td>
<td>Level overallocated resources ................................ 262</td>
</tr>
<tr>
<td></td>
<td>Check the plan's cost and finish date ......................... 268</td>
</tr>
<tr>
<td></td>
<td>Inactivate tasks (Project Professional only) .................. 272</td>
</tr>
<tr>
<td></td>
<td>Skills review .................................................... 273</td>
</tr>
<tr>
<td></td>
<td>Practice tasks ................................................... 274</td>
</tr>
<tr>
<td></td>
<td>Examine resource allocations over time ....................... 274</td>
</tr>
<tr>
<td></td>
<td>Resolve resource overallocations manually ................... 275</td>
</tr>
<tr>
<td></td>
<td>Level overallocated resources ................................ 275</td>
</tr>
<tr>
<td></td>
<td>Check the plan's cost and finish date ......................... 276</td>
</tr>
<tr>
<td></td>
<td>Inactivate tasks (Project Professional only) .................. 278</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13</th>
<th>Organize plan details ........................................... 279</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Practice files .................................................. 279</td>
</tr>
<tr>
<td></td>
<td>Sort plan details ............................................... 280</td>
</tr>
<tr>
<td></td>
<td>Group plan details ............................................. 284</td>
</tr>
<tr>
<td></td>
<td>Filter plan details ............................................. 289</td>
</tr>
<tr>
<td></td>
<td>Create new tables ............................................... 295</td>
</tr>
<tr>
<td></td>
<td>Create new views ............................................... 299</td>
</tr>
<tr>
<td></td>
<td>Skills review .................................................... 303</td>
</tr>
<tr>
<td></td>
<td>Practice tasks ................................................... 304</td>
</tr>
<tr>
<td></td>
<td>Sort plan details ............................................... 304</td>
</tr>
<tr>
<td></td>
<td>Group plan details ............................................. 305</td>
</tr>
</tbody>
</table>
Filter plan details ................................................ 306
Create new tables ............................................. 307
Create new views ............................................. 308

Track progress: Detailed techniques .................. 311
Practice files .................................................. 311
Update a baseline ........................................... 312
Track actual and remaining work for tasks and assignments ........ 315
Track timephased actual work for tasks and assignments .......... 321
Reschedule incomplete work ................................ 327
Skills review .................................................. 328
Practice tasks .................................................. 329
  Update a baseline ........................................... 329
  Track actual and remaining work for tasks and assignments .... 330
  Track timephased actual work for tasks and assignments ....... 331
  Reschedule incomplete work ................................ 332

View and report project status .......................... 333
Practice files .................................................. 333
Examine a plan’s variance ................................ 334
Identify tasks that have slipped .......................... 338
Examine task costs .......................................... 342
Examine resource costs .................................... 346
Skills review .................................................. 349
Practice tasks .................................................. 350
  Examine a plan’s variance ................................ 350
  Identify tasks that have slipped .......................... 351
  Examine task costs .......................................... 352
  Examine resource costs .................................... 353
Part 4: In-depth and special subjects

16 Format and print views: In-depth techniques .......................... 357
Practice files ................................................. 357
Format a Gantt chart view .................................. 358
Format a Timeline view ................................... 364
Format a Network Diagram view ......................... 368
Format a Calendar view .................................. 372
Print and export views .................................... 374
Skills review .................................................. 378
Practice tasks ................................................ 379
  Format a Gantt chart view ................................ 379
  Format a Timeline view ................................ 381
  Format a Network Diagram view ..................... 382
  Format a Calendar view ................................ 383
  Print and export views .................................. 384

17 Format reports: In-depth techniques ......................... 387
Practice files ................................................. 387
Create a custom report .................................... 387
Customize charts in a report ............................. 392
Customize tables in a report ............................. 396
Skills review .................................................. 398
Practice tasks ................................................ 399
  Create a custom report ................................ 399
  Customize charts in a report ......................... 400
  Customize tables in a report ......................... 401

18 Customize Project ............................................. 403
Practice files ................................................. 403
Share custom elements between plans .................. 403
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td><strong>Share information with other programs</strong></td>
</tr>
<tr>
<td></td>
<td>Practice files</td>
</tr>
<tr>
<td></td>
<td>Copy Project data to and from other programs</td>
</tr>
<tr>
<td></td>
<td>Open files in other formats in Project</td>
</tr>
<tr>
<td></td>
<td>Save to other file formats from Project</td>
</tr>
<tr>
<td></td>
<td>Generate reports with Excel and Visio</td>
</tr>
<tr>
<td></td>
<td>Skills review</td>
</tr>
<tr>
<td></td>
<td>Practice tasks</td>
</tr>
<tr>
<td></td>
<td>Share custom elements between plans</td>
</tr>
<tr>
<td></td>
<td>Record and run macros</td>
</tr>
<tr>
<td></td>
<td>Edit macros</td>
</tr>
<tr>
<td></td>
<td>Customize the ribbon and Quick Access Toolbar</td>
</tr>
<tr>
<td>20</td>
<td><strong>Consolidate projects and resources</strong></td>
</tr>
<tr>
<td></td>
<td>Practice files</td>
</tr>
<tr>
<td></td>
<td>Share a resource pool across multiple plans</td>
</tr>
<tr>
<td></td>
<td>Consolidate plans</td>
</tr>
<tr>
<td></td>
<td>Create dependencies between plans</td>
</tr>
<tr>
<td></td>
<td>Skills review</td>
</tr>
</tbody>
</table>
Practice tasks ................................................................. 465
Share a resource pool across multiple plans ....................... 465
Consolidate plans ......................................................... 466
Create dependencies between plans .................................. 466

**Use Agile project management with Project** ......................... 469
Practice files ................................................................. 469
Navigate the Agile project management template .................. 470
Reset the Agile project management template ...................... 472
Create the product backlog .............................................. 476
Create the Agile team ..................................................... 478
Plan a sprint ................................................................. 479
Record progress from daily scrum meetings ......................... 483
Generate reports for sprint reviews .................................... 486
Sources for more information .......................................... 488
Skills review .................................................................. 489
Practice tasks ................................................................. 490
  Navigate the Agile project management template ....... 490
  Reset the Agile project management template ......... 491
  Create the product backlog ....................................... 493
  Create the Agile team ................................................. 494
  Plan a sprint .............................................................. 495
  Record progress from daily scrum meetings .......... 498
  Generate reports for sprint reviews ....................... 500

Part 5: Appendixes

**A short course in project management** ............................... 505
Understand what defines a project .................................... 505
The project triangle: View projects in terms of time, cost, and scope ....... 507
  Time ........................................................................ 507
Author Acknowledgments

Thank you to the many people who supported me while writing this book. I thank my technical editor, Christine Flora, for her insightful thoughts and technical expertise. I thank James Mills, Jr., for his expertise as a co-author of Chapter 21 and his great collaboration. A special thank you to my husband, my family, and my friends who supported me during this process. Thank you also out to the amazing editorial team who ensured the book’s quality.

—Cindy Lewis
This page intentionally left blank
Welcome! This *Step by Step* book has been designed so that you can read it from the beginning to learn about Microsoft Project 2019 and then build your skills as you learn to perform increasingly specialized procedures. Alternatively, if you prefer, you can jump in wherever you need ready guidance for performing tasks. The how-to steps are delivered crisply and concisely—just the facts. You’ll also find informative, full-color graphics that support the instructional content.

**Who this book is for**

*Microsoft Project 2019 Step by Step* is designed for use as a learning and reference resource by home and business users of Microsoft programs who want to use Project to create and manage projects more efficiently. The content of the book is designed to be useful both for people who have previously used earlier versions of Project and for people who are discovering Project for the first time.

**The *Step by Step* approach**

The book’s coverage is divided into chapters representing general Project skill sets. Each part is divided into chapters representing skill set areas, and each chapter is divided into topics that group related skills. Each topic includes expository information followed by generic procedures. At the end of each chapter is a series of practice tasks you can complete on your own by using the skills taught in the chapter. You can use the practice files that are available from this book’s website to work through the practice tasks, or you can use your own files.
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Folder</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 3: Advanced scheduling techniques</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 9: Fine-tune task scheduling | Ch09 | ScheduleTasksAdvanced.mpp  
ViewTaskPath.mpp |
| 10: Fine-tune task details | Ch10 | FineTuneTasks.mpp |
| 11: Fine-tune resource and assignment details | Ch11 | FineTuneAssignments.mpp  
FineTuneResources.mpp |
| 12: Fine-tune the Project plan | Ch12 | FineTunePlan.mpp |
| 13: Organize plan details | Ch13 | OrganizeDetails.mpp |
| 14: Track progress: Detailed techniques | Ch14 | RescheduleIncompleteWork.mpp  
TrackTimephasedWork.mpp  
TrackWork.mpp  
UpdateBaseline.mpp |
| 15: View and report project status | Ch15 | ReportStatus.mpp |
| **Part 4: In-depth and special subjects** | | |
| 16: Format and print views: In-depth techniques | Ch16 | FormatInDepth.mpp |
| 17: Format reports: In-depth techniques | Ch17 | FormatReportsInDepth.mpp |
| 18: Customize Project | Ch18 | CustomizeProjectA.mpp  
CustomizeProjectB.mpp |
| 19: Share information with other programs | Ch19 | SampleTaskList.xlsx  
ShareInformation.mpp |
| 20: Consolidate projects and resources | Ch20 | ConsolidatePlansA.mpp  
ConsolidatePlansB.mpp  
ShareResourcesA.mpp  
ShareResourcesB.mpp |
| 21: Use Agile Project Management with Project | Ch21 | AgileTeam.mpp  
GenerateReports.mpp  
ProductBacklog.mpp  
RecordProgress.mpp  
TemplateReset.mpp  
WorkingSprint.mpp |
Introduction

**Ebook edition**

If you're reading the ebook edition of this book, you can do the following:

- Search the full text
- Print
- Copy and paste


**Adapt procedure steps**

This book contains many images of the Project user interface elements (such as the ribbon and the program window) that you'll work with while performing tasks in Project on a Windows computer. Depending on your screen resolution or window width, the Project ribbon on your screen might look different from the one shown in this book. (If you turn on Touch mode, the ribbon might display some commands in a different layout.) As a result, procedural instructions that involve the ribbon might require a little adaptation.

Simple procedural instructions use this format:

1. On the **Task** tab, in the **View** group, click the **Gantt Chart** button.

If the command is in a list, our instructions use this format:

1. On the **View** tab, in the **Data** group, click the **Filter** arrow and then, in the **Filter** list, click **Summary Tasks**.

If differences between your display settings and ours cause a button to appear differently on your screen than it does in this book, you can easily adapt the steps to locate the command. First click the specified tab and then locate the specified group. If a group has been collapsed into a group list or under a group button, click the list or button to display the group's commands. If you can't immediately identify the button you want, point to likely candidates to display their names in ScreenTips.
Multistep procedural instructions use this format:

1. On the **View** tab, in the **Resource Views** group, click the **Resource Sheet** button to display the Resource Sheet view.

2. On the **View** tab, in the **Data** group, click the **Tables** button and then click **Cost**.

The instructions in this book assume that you’re interacting with onscreen elements on your computer by clicking (with a mouse, touchpad, or other hardware device). If you’re using a different method—for example, if your computer has a touchscreen interface and you’re tapping the screen (with your finger or a stylus)—substitute the applicable tapping action when you interact with a user interface element.

Instructions in this book refer to Project user interface elements that you click or tap on the screen as **buttons** and refer to physical buttons that you press on a keyboard as **keys**, to conform to the standard terminology used in documentation for these products.

When the instructions tell you to enter information, you can do so by typing on a connected external keyboard, tapping an onscreen keyboard, or even speaking aloud, depending on your computer setup and your personal preferences.

## How to get support & provide feedback

The following sections provide information on errata, book support, feedback, and contact information.

### Errata & book support


If you discover an error that is not already listed, please submit it to us at the same page.
Introduction

If you need additional support, email Microsoft Press Book Support at microsoftpresscs@pearson.com.

Please note that product support for Microsoft software and hardware is not offered through the previous addresses. For help with Microsoft software or hardware, go to http://support.microsoft.com.

Stay in touch

Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress.
Part 2

Simple scheduling basics

CHAPTER 3
Start a new plan .......................................................... 37

CHAPTER 4
Build a task list .......................................................... 49

CHAPTER 5
Set up resources .......................................................... 79

CHAPTER 6
Assign resources to tasks ............................................ 99

CHAPTER 7
Format and share your plan ........................................... 125

CHAPTER 8
Track progress: Basic techniques ................................ 153
Practice files

No practice files are necessary to complete the practice tasks in this chapter.

A project’s schedule or plan is essentially a model that you construct for some project aspects that you are anticipating—what you expect will happen, or what you want to happen. This model focuses on certain key aspects of a project, such as tasks, resources, time frames, and possible associated costs. Note that this book refers to the types of documents that Project 2019 works with as *plans*, not documents or schedules.

This chapter guides you through procedures related to creating a new plan and setting its start date, setting nonworking days in a project calendar, and entering a plan’s title and other properties.

Create a new plan and set its start date

As you might expect, Project focuses primarily on time. Sometimes you might know the expected start date of a project, the expected finish date, or both. However, when working with Project, you specify only one date, not both—either the plan’s start date or its finish date.

In this chapter

- Create a new plan and set its start date
- Set nonworking days in the project calendar
- Enter the plan title and other properties
Chapter 3: Start a new plan

After you enter the plan's start date or finish date and any additional details, Project calculates the other date for you. Remember that Project is not merely a static repository of your schedule information or a Gantt chart drawing tool—it is an active scheduling engine.

Most plans should be scheduled from a start date, even if you know that the plan should finish by a certain deadline date. Scheduling from a start date sets all tasks to begin as soon as possible and gives you the greatest scheduling flexibility. In this chapter and later chapters, you will see this flexibility in action as you work with a plan that is scheduled from a start date.

To create a new plan

1. In Project, if the File tab is displayed, click it and then click New.
2. In the list of templates, click Blank Project or any other template you want.

Or

1. If you already have a list of available templates on the Start screen, click Blank Project or any other template you want.

When you create a new plan, Project sets the plan's start date to the current date. As Figure 3-1 shows, Project draws a thin green vertical line in the chart portion of the Gantt Chart view at the current date.

TIP Line formatting can be changed to accommodate color blindness. See Chapter 16, "Format and print views: In-depth techniques," and its discussion on gridlines.

FIGURE 3-1 The current date is shown in the Gantt Chart view; look for the green vertical line (your current date likely differs).

TIP The current date line is drawn at the start of the day.
To set (or change) the plan’s start date

1. On the **Project** tab, in the **Properties** group, click **Project Information**.

2. In the **Project Information** dialog box, in the **Start Date** box, either enter the start date you want or click the arrow to select one from the calendar.

   **TIP** In the calendar, you can use the left and right arrows to navigate to any month and then click the date you want, or you can click **Today** to quickly choose the current date.

3. Click **OK** to accept the start date and close the **Project Information** dialog box.

To save the new plan

1. Click the **File** tab, and then click **Save As**.

2. On the **Save As** page, navigate to the location where you want to save the plan.

   **TIP** You can adjust Project settings related to files. For example, you can set Project to automatically display the Project Information dialog box each time you create a new plan. To make this change, click the File tab and then click **Options**. In the Project Options dialog box, click **Advanced**, and then, under **General**, select the check box titled **Prompt for Project Info for New Projects**. You can also instruct Project to automatically save the active plan at predefined intervals, such as every 10 minutes. In the Project Options dialog box, click **Save**, select the **Auto Save Every** check box, and then specify the time interval you want.

Set nonworking days in the project calendar

Calendars are the primary means by which you control when each task and resource can be scheduled for work in Project. In later chapters, you will work with other types of calendars; in this chapter, we focus on the project calendar.

The project calendar defines the general working and nonworking days and times for tasks for the entire plan. Project includes multiple calendars, called base calendars, and any one of those calendars can serve as the project calendar for a plan. As Figure 3-2 shows, you select the base calendar to be used as the project calendar in the Project Information dialog box.
FIGURE 3-2 Set the plan’s start date, project calendar, and other essential schedule settings in the Project Information dialog box.

**IMPORTANT** If you are using Project Professional instead of Project Standard, be aware that the Project Information dialog box and some other dialog boxes may contain additional options related to Project Online or Project Server. For more information, see Appendix C, “Collaborate: Project, SharePoint, and PWA.”

The Calendar list contains the three base calendars that are included with Project:

- **24 Hours** Has no nonworking time; all time is working time.
- **Night Shift** Covers a night shift schedule of Monday night through Saturday morning, 11:00 P.M. to 8:00 A.M. (23:00 to 08:00), with a 1-hour break each day.
- **Standard** The traditional working day and week, Monday through Friday from 8:00 A.M. to 5:00 P.M. (08:00 to 17:00), with a 1-hour break each day.

Only one of the base calendars serves as the project calendar; the Standard calendar is the default.

Think of the project calendar as your organization’s normal working days and hours. For example, this might be Monday through Friday, 8:00 A.M. through 5:00 P.M. (08:00 to 17:00), with a 1-hour lunch break each day. Your organization or specific resources might have exceptions to this normal working time, such as public holidays or vacation days (personal holidays). You’ll address resource vacations in Chapter 5, “Set up resources.”

You customize calendars as shown in Figure 3–3 in the Change Working Time dialog box, which opens when you click the Change Working Time button on the Project tab.
Set nonworking days in the project calendar

The selected day’s working times

FIGURE 3-3  You customize a calendar’s working time in the Change Working Time dialog box.

Use this dialog box to set normal working schedules and working time exceptions for individual resources or the entire plan. Other common examples of working time adjustments include the following:

- Recurring holidays or other times off that follow a known pattern, such as weekly, monthly, or annually.
- Variable working times per week—for example, to address seasonal changes in working times.
- Unique working hours for a resource. You’ll adjust such settings in Chapter 5.

To select the project calendar

1. On the Project tab, in the Properties group, click the Project Information button.
2. In the Project Information dialog box, in the Calendar box, click the arrow and then click the calendar you want to use as the project calendar.
Chapter 3: Start a new plan

To set a specific date as nonworking

1. On the Project tab, in the Properties group, click the Change Working Time button.
2. On the Exceptions tab in the lower portion of the Change Working Time dialog box, in the Name field, enter a description of the exception.

![TIP] You don’t need to name calendar exceptions, but it’s a good practice for you or others to identify the reason for the exception.

3. In the Start and Finish fields, enter or select the dates you want.
4. Click OK.

To set up a recurring nonworking time

1. On the Project tab, in the Properties group, click the Change Working Time button.
2. On the Exceptions tab of the Change Working Time dialog box, in the Name field, enter a description of the recurring exception.
3. Click in the Start field, and then click Details.
4. In the Details dialog box, under Recurrence Patterns, select the recurrence values you want, and then click OK.
5. Click OK to close the Change Working Time dialog box.

To set up a custom work week

1. On the Project tab, in the Properties group, click the Change Working Time button.
2. Click the Work Weeks tab in the lower portion of the Change Working Time dialog box.
3. Click a row below the [Default] value.
4. Enter a description and the date range you want to apply to the custom work week.
5. In the Start and Finish fields, enter or select the date range you want to apply to the custom work week.
6. Click Details.
7. In the Details dialog box, select the day and time values you want, and then click OK.

8. Click OK to close the Change Working Time dialog box.

Enter the plan title and other properties

As with other Microsoft Office apps, Project keeps track of several document properties. Some of these properties are statistics, such as how many times the document has been revised. Other properties include information that you might want to record about a plan, such as the project title, the project manager’s name, or keywords to support a file search. Some of these properties are used in views, reports, and page headers and footers when printing. You can view and record these properties in the Properties dialog box shown in Figure 3-4.

FIGURE 3-4 Record useful summary information about a plan in the Properties dialog box.
Chapter 3: Start a new plan

TIP  The project title and comments automatically appear on the Project Summary Task. For more information, see Chapter 4, “Build a task list.”

To enter a plan’s properties

1. Click the File tab, and then click Info.
2. On the right side of the Info screen, click Project Information. In the menu that appears, click Advanced Properties.
3. Enter the properties you want to record (all are optional), and then click OK.

Project management focus: Project is part of a larger picture

Depending on your needs and the information to which you have access, the plans that you develop in Project might not deal with other important aspects of your projects. For example, many large projects take place in organizations that have a formal change-management process. Before a major change to the scope of a project is allowed, the people managing and implementing the project must evaluate and approve the change. Even though this is an important project-management activity, it is not done directly within Project.

Skills review

In this chapter, you learned how to

■ Create a new plan and set its start date
■ Set nonworking days in the project calendar
■ Enter the plan title and other properties
Practice tasks

No practice files are necessary to complete the practice tasks in this chapter.

**IMPORTANT** If you are running Project Professional, Project Online Professional, or Project Online Premium, make sure your Project desktop client is not connected to Project Web App but is instead set to Computer mode. For more information, see Appendix C.

Create a new plan and set its start date

The scenario: Throughout this book, you play the role of a project manager at Lucerne Publishing, a book publisher that specializes in children’s books. Lucerne is about to publish a major new book, and you’ve been asked to develop a plan for the book launch. Start Project and perform the following tasks:

1. Create a new plan based on the Blank Project template.
2. Set the new plan’s start date to January 9, 2023.
3. Save the new plan as Simple Plan.

Set nonworking days in the project calendar

The scenario: At Lucerne Publishing, you need to account for an upcoming date on which the entire Lucerne staff will be unavailable to work on the book launch project. Continuing in the Simple Plan plan, perform the following task:

1. In the project calendar, create a nonworking day calendar exception named Staff at morale event for January 25, 2023, which is illustrated in Figure 3-5.
Enter the plan title and other properties

The scenario: You want to record top-level information about the new book launch plan. These details don’t affect the overall schedule, but they relate to important supplemental information you want to keep in the plan. Continuing in the Simple Plan plan, perform the following task:

1. Give the Simple Plan the following properties:
   - Subject: New book launch schedule
   - Manager: Carole Poland
   - Company: Lucerne Publishing
   - Comments: New children’s book for spring release
2. Review the Gantt Chart view for this plan and, in the timescale, locate the vertical current date line and the date for the morale event you created in the previous section.

Notice that the morale event is shaded the same way as other nonworking time in the timescale.

**TIP** If you do not see the shading for nonworking time, check to make sure you are viewing the timescale by days instead of by weeks or months.
Index

Symbols
% Complete column (tables), progress tracking, 162

Numbers
8/80 rule, accuracy in durations (tasks), 56–57
24 Hour calendars (plans), 40

A
accessibility, 6
Account page (Backstage view), 19
accuracy in durations (tasks), 56–57
active view (report), 14
activities. See tasks
actual costs, 268, 319–320
actual values
   collecting from resources, 325–326
   manually entering, 326
actual/remaining work in tasks/assignments, tracking, 315–320
Lucerne Publishing practice example, 330–331
timephased work, 321–327, 331–332
actuals and progress tracking, 153
Agile project management, 469–470, 488
   Agile teams, creating, 478–479, 494–495
   childhood behavior and, 476
   product backlogs
      assigning/unassigning work items, 481–482
      creating, 476–477, 493–494
      updating, 483
   resources, 488–489
   scrum meetings, recording progress from, 483–485, 498–500
   sprints, 478
      generating reports, 486–488, 500–501
      planning, 479–483, 495–498
   Team Planner view, 480, 484
   templates
      navigating, 470–472, 490–491
      resetting, 472–475, 490–491
ALAP (As Late As Possible) constraint, 183
allocations (resources), 256–257
   evaluating, 258, 274
   example of, 257
   fully allocated resources, 256
graphing against a timescale, 260
overallocated resources, 256, 258
   editing assignment-level work, 261
   finding, 259–260
   leveling resources, 262–268, 275–276
   manually adding level delays, 261–262
   resolving manually, 260–262, 275
   Resource Allocation view, 257, 258, 259–260
   Resource Usage view, 257, 258–259, 260–261
underallocated resources, 256, 258
ASAP (As Soon As Possible) constraint, 183, 184–185
assigning resources to tasks
   checking plans after resource assignments, 112–116, 122–123
   cost resources, 111–112, 121–122
   effort-driven scheduling, 105–111
      changing schedule results when removing resources from tasks, 111, 120–121
      managing for specific tasks, 111
   Lucerne Publishing practice example, 117–119
   material resources, 240–241, 242
   work items to product backlogs, 481–482
   work resources, 100–105, 117–119
assignment units, 196
assignments (resources)
   actual/remaining work, tracking, 315–320, 330–331
   contours, applying to assignments (resources), 236–239, 251–252
   incomplete work, rescheduling, 327–328, 332
   manually editing work per time period, 239
      start dates, delaying, 235–236, 251
   tasks and, breaking relationships, 326
   Team Planner view, adjusting in, 244–247, 254
timephased work, progress tracking, 321–327, 331–332
AutoFilter, 8
automatically scheduled tasks, 50
durations, 55, 57–58
rescheduling, 63
switching to manually scheduled tasks, 51–53, 72
availability (work resources), 80, 228–230, 248

B
backlogs (product)
   assigning/unassigning work items, 481–482
   creating, 476–477, 493–494
   updating, 483
Backstage view

Backstage view, 8, 16, 18
Account page, 19
  exiting, 20
Export page, 19
Info page, 18–19
New page, 19
  creating plans as blank projects, 21
  creating plans from templates/other plans, 21
  pinning templates to, 19–20
Open page
  pinning folders to, 19
  pinning plans to, 19
options, 18
plans
  creating as blank projects, 21
  creating from templates/other plans, 21
  opening, 21
  saving, 21
Print page, 19
Project integration, 7
Project Options dialog, 19
Share page, 19
templates, creating from existing plans, 21–22
baselines (plans)
clearing previously saved baselines, 158
comparing, 312–313, 314
costs, 268
displaying
  Gantt bar baselines in Gantt Chart view, 158
  values with Variance tables, 158
removing, 315
saving, 155–158, 168
updating, 312–315, 326–330
variance, 334–337, 350
blank projects, creating plans as, 21
bottom-up planning, 60
Budget Cost visual reports, 344–345, 346
Burndown reports and variance, 336–337

C
Calendar view, formatting, 372–374, 383–384
calendars (plans)
  24 Hour calendars, 40
  customizing, 404
  new base calendars, creating/applying in tasks, 191–193
Night Shift calendars, 40
nonworking days, setting, 39–40
  Lucerne Publishing practice example, 45–46
  recurring nonworking days, 42
  specific dates, 42
resource calendars, 86–87
  assigning a different base calendar to a resource, 90
  modifying work days/times, 89–90, 96
  specifying exceptions for work resources, 87–88
  selecting, 41
  standard base calendars, 190–191
  Standard calendars, 40
  work resources, specifying for, 87–88
  work weeks, customizing, 42–43
callouts, switching task bars to callouts in Timeline view, 135–136
capacity (maximum), work resources, 82–83
  Lucerne Publishing practice example, 95
  viewing, 242–244, 253–254
Cash Flow reports, 344, 345
change highlighting, task scheduling, 175
charts
  adding to reports, 391
  customizing in reports, 392–396, 400–401
  in reports, 28–29
childhood behavior and Agile project management, 476
collapsing/expanding ribbon interface, 16
collecting actual values from resources, 325–326
columns (tables), adding, 298–299
combination (split) view, 22
displaying, 28
  primary/secondary views, 26
  reports, 30–31
  Task Form, 26
commands, 14
  ribbon interface, 17
  Task tab (ribbon interface), 17
touch input and, 17
comparing baselines (plans), 312–313, 314
completion percentages, tasks, 160–163, 169–170
consolidated plans, 456–457, 466
creating, 459
displaying project summary tasks, 460
insert plans, 457–458, 459
simplicity of, 459
uses of, 457
constraints, scheduling tasks with, 182, 204
  applying constraints, 186–188
  flexible constraints, 182
  ALAP constraint, 183
  ASAP constraint, 183, 184–185
  inflexible constraints, 183
  MFO constraint, 184
  MSO constraint, 184, 185–186
critical paths
  crashing, 217
  defined, 217
  free slack, 217–218
  slack/float, 217–218
  changing slack threshold, 219
  displaying slack for noncritical tasks, 219
  viewing, 217–219, 225
cross-plan links, creating, 460–464, 466–467
current (scheduled) costs, 268
current date lines (plans), 38
custom fields, 8
custom reports, creating, 387–390, 391
  charts
    adding to reports, 391
    customizing in reports, 392–396, 400–401
    images, adding to reports, 392
    Lucerne Publishing practice example, 399–400
  shapes, adding to reports, 392
  tables
    adding to reports, 392
    customizing in reports, 396–398, 401–402
    text boxes, adding to reports, 392
customizing
  calendars (plans), 40–41, 404
  charts in reports, 392–396, 400–401
  fields (tables), creating, 296–297
  filters, 294
  Gantt Chart view, 126–129, 146–148
  global templates, 404, 406–407, 418–419
  groups, editing, 286–288
  plans, formatting changes, 38
  Quick Access Toolbar, 413–414, 415–416, 421–422
  reports, 137–139
    charts, 392–396, 400–401
    Lucerne Publishing practice example, 149–150
    page setup options, 145
    tables, 396–398, 401–402
  ribbon interface, 8, 414, 416–417, 421–422
  tables in reports, 396–398, 401–402
  views, 377, 384
D
data maps, opening files in other formats in Project, 428–431, 441–443
date ranges, changing
  pay rates over different date ranges, 233–234, 250
  resource availability over multiple date ranges, 228–230, 248
deadline dates (tasks), 209–211
  removing, 211
  setting, 211, 223
dedicated resource pools, creating, 451
delaying
  overallocated resources, manually adding level
  delays, 261–262
  resource assignment start dates, 235–236, 251
deleting
  constraints from tasks, 188
  deadline dates (tasks), 211
  macros, 410
  resources, 81
  tasks, 51
  work resources, 81
deliverables, developing task lists, 51
demoting tasks (outlining plans), 61
dependencies (tasks), 61–62, 64–65
  cross-plan links, 460–464, 466–467
  finish-to-finish relationships (FF), 63
  finish-to-start relationships (FS), 62, 63
  linking tasks, 75–76, 179–182, 203
  start-to-finish relationships (SF), 63
  start-to-start relationships (SS), 62
  summary tasks, 66
  unlinking tasks, 66
Design tab (ribbon interface), 16
displaying
  Budget Cost visual reports, 346
  Cash Flow reports, 345
  Cost tables, 270, 345, 349
  insert plans, details of, 459
  Late Tasks reports, 341
  project summary tasks in consolidated plans, 460
  reports, 139
  Resource Cost Overview reports, 349
  scheduled/baselines values with Variance tables, 158
  Scrum Template Instructions view, 472
  slack for noncritical tasks, 219
  Slipping Tasks reports, 341
  Task Cost Overview reports, 345
  Tracking Gantt view, 341
  Variance tables, 341
documenting
  resources, 91–92, 98
  tasks, 68–70
    adding hyperlinks to tasks, 69
    adding notes to tasks, 69
    Lucerne Publishing practice example, 77–78
    removing formatting from tasks, 70
    removing hyperlinks from tasks, 70
    removing notes from tasks, 70
drawing on Gantt charts, 129–130
durations (tasks), 53–54, 58
  8/80 rule, 56–57
  abbreviations, 55
  accuracy in, 56–57
  automatically scheduled tasks, 55, 57–58
  checking, 66–68, 76–77
  elapsed durations, 56
  example of, 54
  fixed duration task type, 194, 197
  Lucerne Publishing practice example, 73
  manually scheduled tasks, 55, 57–58, 63
  milestones, 58–59
  nonworking days, 55, 58
E
  editing macros, 410–412, 420–421
  effort-driven scheduling, 105–111
    changing schedule results when removing
    resources from tasks, 111, 120–121
    managing for specific tasks, 111
    task types and, 198–199
equipment durations (tasks), 56
  equipment resources, 81–82
  estimates. See durations
Excel
  copying/pasting to, 8
  generating reports in, 435–438, 444–445
  exceptions (calendar), specifying for work resources, 87–88
  expanding/collapsing ribbon interface, 16
  Export page (Backstage view), 19
  exporting views as PDF or XPS file, 377–378, 384
F
  Feedback smiley button, 13
  Field List pane (reports), 28–29
  fields (custom), creating, 296–297
  File tab (ribbon interface), 16, 18
  files in other formats
    changing formatting, 431
    opening in Project, 428–431, 441–443
    saving to other formats in Project, 431–435, 443–444
  filtering
    built-in filters, 294
    creating/editing filters, 292–294
    custom filters, 294
    plan details, 289–295, 306
    resources
      by built-in/custom filters, 294
      by column headings, 292
ID numbers, tasks

I

ID numbers, tasks, 49
images
  copying/pasting from another program into Project, 427
  in reports, 28–29, 392
importing files, opening files in other formats in Project, 428–431, 441–443
inactive tasks, 272–273, 278
incomplete work, rescheduling, 327–328, 332
inflexible constraints, 183
  MFO constraint, 184
  MSO constraint, 184, 185–186
Info page (Backstage view), 18–19
insert plans, 457–458, 459
interactive tasks, 9
interim plans, 313–314, 315
interrupting work on tasks, 188–189, 204–205

L

lag time, relationships (tasks), 180, 181, 182
Late Tasks reports and variance, 340, 341
Layout tab (ribbon interface), 16
lead time, relationships (tasks), 180–181, 182
levelling overallocated resources, 261–262, 275–276
Levelling Gantt view
  overallocated resources, 266–268
  resource allocation, 258
linking
  plans to resource pools, 454
  tasks (dependencies), 61–62, 64–65, 179–182, 460–464
    finish-to-finish relationships (FF), 63
    finish-to-start relationships (FS), 62, 63
  Lucerne Publishing practice example, 75–76, 203, 466–467
    start-to-finish relationships (SF), 63
    start-to-start relationships (SS), 62
  summary tasks, 66
  unlinking tasks, 66
Lucerne Publishing practice example
Agile project management
  Agile teams, 494–495
  navigating templates, 490–491
  product backlogs, 493–494
  recording progress from scrum meetings, 498–500
  resetting templates, 491–493
  sprints, generating, 500–501
  sprints, planning, 495–498
  assigning resources to tasks
  checking plans after resource assignments, 122–123
  cost resources, 121–122
  effort-driven scheduling, 120–121
  work resources, 117–119
  assignments (resources), tracking actual/remaining work in tasks/assignments, 330–331
availability
  changing over multiple date ranges, 248
  customizing, 248
baselines
  saving, 168
  updating, 326–330
consolidated plans, 466
copying, applying to assignments (resources), 251–252
copying/pasting data, pasting Project data into other programs, 440
costs, fixed costs in plans, 223–224
critical paths, viewing, 225
cross-plan links, 466–467
custom reports, creating, 400–401
custom reports, creating, 400–401
durations (tasks), checking, 76–77
duration tasks, saving to other formats in Project, 443–444
fixed costs in plans, 223–224
Gantt Chart view, customizing, 146–148
global templates, customizing, 418–419
incomplete work, rescheduling, 332
macros
  editing, 420–421
  recording/running, 419–420
material resources
  assigning, 252–253
  creating, 252–253
milestones, 74
opening files in other formats in Project, 441–443
organizing plan details
  creating tables, 307–308
  creating views, 308–310
  filtering details, 306
  grouping details, 305
  sorting details, 304–305
pay rates
  changing pay rates over different date ranges, 250
  multiple resource pay rates, 249–250
plans
  checking durations, 76–77
  checking finish dates, 76–77
  consolidated plans, 466
costs, 276–277
creating, 45
customizing templates, 418–419
finish dates, 276–277
fixed costs in plans, 223–224
scheduling start dates, 45
progress tracking
actual values, 170–172
completion percentages, 169–170
saving baselines, 168
tracking plans as scheduled, 169
Quick Access Toolbar, customizing, 421–422
recurring tasks, 224–225
reports
copying, 150–151
customizing, 149–150
printing, 151–152
reports, generating in Excel or Visio, 444–445
resource assignments
adjusting in Team Planner view, 254
applying contours to assignments (resources), 251–252
delaying start dates, 251
resource pools, sharing across plans, 465
resources
configuring work resources, 94
cost resources, 97
documenting, 98
evaluating allocations, 274
leveling overallocated resources, 275–276
Max. Units field, 95
maximum capacity, 95
modifying work days/times, 96
pay rates, 95–96
resolving overallocated resources manually, 275
viewing maximum capacity, 253–254
ribbon interface, customizing, 421–422
summary tasks, scheduling manually, 226
tasks
adding to Timeline view, 148–149
constraints, scheduling tasks with, 204
creating, 71
documenting, 77–78
durations, 73
inactive tasks, 278
interrupting work on tasks, 204–205
linking tasks (dependencies), 75–76, 203
milestones, 74
outlining plans with summary tasks, 74–75
scheduling, 72
seeing task relationships with Task Path, 202
setting deadline dates, 223
summary tasks, scheduling manually, 226
switching automatically scheduled tasks/
manually scheduled tasks, 72
task types, 206–207
tracking actual/remaining work in tasks/
assignments, 330–331
viewing task details with Task Inspector, 207–208
working time for individual tasks, adjusting, 205
Timeline view, adding tasks to, 148–149
timephased work, progress tracking, 331–332
variance, reporting, 349
views
copying, 150–151
exporting as PDF or XPS file, 384
formatting, 379–384
printing, 151–152, 384
M
macros
deleting, 410
editing, 410–412, 420–421
recording, 407–409, 419–420
running, 410, 419–420
security, 409
managing projects. See also Agile project management
changing scope of projects, 44
perspective of, 9–10
sharer plans in resource pools, 455–456
manually scheduled tasks, 8, 50, 194
durations, 55, 57–58
rescheduling, 63
switching to automatic scheduled tasks, 51–53, 72
maps (data), opening files in other formats in Project, 428–431, 441–443
material resources, 239–240
assigning, Lucerne Publishing practice example, 252–253
assigning to tasks, 240–241, 242
creating, 241, 252–253
defined, 79
fixed consumption rates, 241
variable consumption rates, 241
Max. Units field (work resources), 82–83, 95
maximum capacity, work resources, 82–83
Lucerne Publishing practice example, 95
viewing, 242–244, 253–254
MFO (Must Finish On) constraint, 184
milestones, 58–59, 74
Mini Toolbars, 15
MSO (Must Start On) constraint, 184, 185–186

MSO (Must Start On) constraint
naming

plans, 43–44, 46–47
tasks, 50
work resources, 80–81
navigating Agile project management templates, 470–472
Network Diagram view, formatting, 368–371, 382–383

new features
Project 2010, 8–9
Project 2013, 7
Project 2016, 6–7
Project 2019, 5–6
New page (Backstage view), 19
pinning templates to, 19–20
Night Shift calendars (plans), 40
nonworking days
 durations, 55, 58
 setting in calendars, 39–40
 Lucerne Publishing practice example, 45–46
 recurring nonworking days, 42
 specific dates, 42
notes
 resources, documenting, 91–92, 98
 tasks, documenting
 adding notes to tasks, 69
 Lucerne Publishing practice example, 77–78
 removing notes from tasks, 70

Office, Project support, 7
OneDrive, Project integration, 7
Open page (Backstage view), pinning folders to, 19
 plans to, 19
opening files in other formats in Project, 428–431, 441–443
Organizer, 18–19
 copying elements of global templates, 404–405, 406–407
 customizing global templates, 406–407
organizing plan details
 filtering details, 289–295, 306
grouping details, 284–289, 305
 sorting details, 280–284, 304–305
tables, creating, 295–299, 307–308
views, creating, 299–303, 308–310
outlining plans with summary tasks, 59–60
demoting tasks, 61
 Lucerne Publishing practice example, 74–75
promoting tasks, 60–61
overallocated resources, 256, 258
 editing assignment-level work, 261
 finding, 259–260
 leveling resources, 262–268, 275–276
 manually adding level delays, 261–262
 resolving manually, 260–262, 275
P
page setup options (reports), 145
panning/zooming Gantt charts in Timeline view, 136–137
pasting
data from other programs into
 Project, 426, 427
images from other programs into Project, 427
Paste Special feature, 425
Project data into other programs, 424–427, 440
paths (critical)
crashing, 217
defined, 217
free slack, 217–218
slack/float, 217–218
 changing slack threshold, 219
displaying slack for noncritical tasks, 219
viewing, 217–219, 225
pay rates, work resources, 83–85
 changing pay rates over different date ranges, 233–234, 250
Lucerne Publishing practice example, 95–96
multiple resource pay rates, 230–232, 249–250
PDF files
 exporting views as, 377–378, 384
 saving as PDF, 9
Peak, 196, 198
people resources, 81–82
pinning to Open page (Backstage view)
folders, 19
 plans, 19
templates, 19–20
plans, 37–38
 Backstage view
 opening plans in, 21
 saving in, 21
baselines
 clearing previously saved baselines, 158
 comparing, 312–313, 314
displaying Gantt bar baselines in Gantt Chart view, 158
displaying values with Variance tables, 158
 removing, 315
saving, 155–158, 168
updating, 312–315, 326–330
variance, 312–315, 334–337
bottom-up planning, 60
calendars
24 Hour calendars, 40
changing start dates, 39
customizing, 404
customizing work weeks, 42–43
Night Shift calendars, 40
resource calendars, 86–90
scheduling start dates, 39
selecting, 41
setting nonworking days, 39, 42–43, 45–46
Standard calendars, 40
checking after resource assignments, 112–116, 122–123
consolidated plans, 456–457, 466
creating, 459
displaying project summary tasks, 460
insert plans, 457–458, 459
simplicity of, 459
uses of, 457
costs, 268–269
actual costs, 268
baseline costs, 268
cost tables, 270
current (scheduled) costs, 268
fixed costs in plans, 212–213, 223–224
Lucerne Publishing practice example, 276–277
remaining costs, 268
reports, 269–270, 271
viewing essential cost/schedule values, 269
creating, 11–13, 38
as blank projects, 21
Lucerne Publishing practice example, 45
sensitive material, 20
templates from existing plans, 21–22
from templates/other plans, 20, 21
critical paths
crashing, 217
defined, 217
free slack, 217–218
slack/float, 217–218, 219
viewing, 217–219, 225
current date lines, 38
dependencies, creating, 460–464, 466–467
durations (tasks), checking, 76–77
filtering details, 289–295, 306
finish dates, 270–271
checking, 66–68, 76–77
Lucerne Publishing practice example, 276–277
fixed costs in plans, 212–213, 223–224
formatting, customizing, 38
global templates
copying elements of, 404–405, 406–407
customizing, 404, 406–407, 418–419
elements of, 404
grouping plan details, 284–289
insert plans, 457–458, 459
interim plans, 313–314, 315
naming, 43–44, 46–47
organizing plan details
creating tables, 295–299, 307–308
creating views, 299–303, 308–310
filtering details, 289–295, 306
grouping details, 284–289, 305
sorting details, 280–284, 304–305
outlining with summary tasks, 59–60, 74–75
demoting tasks, 61
promoting tasks, 60–61
pinning to Open page (Backstage view), 19
progress tracking, tracking plans as scheduled, 158–160, 169
Project Information dialog, automatically
displaying in plans, 39
properties of, entering, 43–44, 46–47
resource pools
dedicated resource pools, creating, 451
linking plans to, 454
sharing across plans, 448–451, 452–456, 465
saving, 21, 39
sharer plans
managing linked plans in resource pools,
455–456
unlinking from resource pools, 455
updating working times in resource pools, 456
sorting plan details, 280–284, 304–305
start dates
changing, 39
scheduling, 38, 39, 45
tasks, linking tasks (dependencies), 460–464, 466–467
top-down planning, 60
predecessor tasks, 62–64, 65–66
lag time, 180, 181, 182
lead time, 180–181, 182
Presentation Styles (Gantt Chart view), 128
Print page (Backstage view), 19
printing
reports, 142, 145, 151–152
views, 142–144, 374–377, 384–385
product backlogs
assigning/unassigning work items, 481–482
creating, 476–477, 493–494
updating, 483
product scope

product scope, 51
progress tracking, 154

<table>
<thead>
<tr>
<th>variance</th>
<th>benefits of, 341</th>
<th>status reports, 337–338</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Online</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Project Online Premium, 4–5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Online Professional, 4–5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Professional, 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>inactive tasks, 272–273</td>
<td></td>
<td></td>
</tr>
<tr>
<td>interactive tasks, 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SharePoint Task Lists, 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skype, 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Team Planner view, 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>project scope, 44, 51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Server, 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Standard, 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Statistics dialog and variance, 334–335</td>
<td>project summary tasks, displaying in consolidated plans, 460</td>
<td></td>
</tr>
<tr>
<td>Project tab (ribbon interface), 16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>projects (blank), creating plans as, 21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>promoting tasks (outlining plans), 60–61</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PWA (Project Web App), 5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q - R

**Quick Access Toolbar**, 13, 413–414, 415–416, 421–422
read-only resource pools, updating, 455
recording macros, 407–409, 419–420
recurring tasks, 213–216
assigning resources to tasks, 216–217
creating, 216
Lucerne Publishing practice example, 224–225
rejoining split tasks, 190
relationships (tasks), 61–62, 64–65
appearances of, 64
changing type of, 181
finish-to-finish relationships (FF), 63, 179
finish-to-start relationships (FS), 62, 63, 179, 180
lag time, 180, 181, 182
lead time, 180–181, 182
linking tasks (dependencies), 179–182, 203
seeing task relationships with Task Path, 176–178, 202
start-to-finish relationships (SF), 63, 179
start-to-start relationships (SS), 62, 179
summary tasks, 66
unlinking tasks, 66
remaining costs, 268
remaining/actual work in tasks/assignments, tracking, 315–320, 330–331
removing
baselines (plans), 315
costs from tasks, 188
deadline dates (tasks), 211
report (active view), 14
report label (view label), 14
Report tab (ribbon interface), 16
reports, 7
Budget Cost visual reports, 344–345, 346
Cash Flow reports, 344, 345
charts in, 28–29
copying, 140, 142, 150–151
cost reports, 269–270, 271
custom reports, creating, 387–390, 391
charts, adding to reports, 391
costs, customizing in reports, 392–396, 400–401
images, adding to reports, 392
Lucerne Publishing practice example, 399–400
shapes, adding to reports, 392
tables, adding to reports, 392
tables, customizing in reports, 396–398, 401–402
text boxes, adding to reports, 392
customizing, 137–139
Lucerne Publishing practice example, 149–150
page setup options, 145
displaying, 139
Field List pane, 28–29
formatting, 138
generating in Excel or Visio, 435–438, 444–445
ingenları, in, 28–29
page setup options, 145
printing, 142, 145, 151–152
Report Tools Design tab, 29–30
Resource Cost Overview reports, 138, 149–150, 151, 152, 348, 349
Resource Overview report, 28
split (combination) view, 30–31
sprint reports (Agile project management),
generating, 486–488, 500–501
status reports and project management, 337–338
Table Tools Design tab, 30
Table Tools Layout tab, 30
tables in, 28–29, 139
Task Cost Overview reports, 343, 345
task costs, 342–343

variance, examining
Burndown reports, 336–337
Cost Overview reports, 336
Late Tasks reports, 340, 341
Project Dashboard reports, 335–337
Project Statistics dialog, 334–335
Slipping Tasks reports, 340–341
“status-at-a-glance” snapshots, 334–335
views versus reports, 390–391
visual reports, generating in Excel or Visio, 435–438, 444–445
rescheduling
  incomplete work, 327–328, 332
tasks, 63–64, 190
Resource Allocation view, 257, 258, 259–260
Resource Cost Overview reports, 138, 149–150, 151, 152, 348, 349
Resource Overview report, 28
resource pools
dedicated resource pools, creating, 451
linking plans to, 454
sharer plans
  managing linked plans in resource pools, 455–456
  unlinking from resource pools, 455
updating working times in resource pools, 456
sharing across plans, 448–451, 452–456, 465
updating read-only resource pools, 455
viewing usage details, 455
Resource sheet view, 24–25
Resource tab (ribbon interface), 16
Resource Usage view, 25, 257, 258–259
  assignments, applying contours to assignments (resources), 236–239
  overallocated resources, resolving manually, 260–261
  resource costs, reporting, 347–348
timephased work, progress tracking, 327
timescale adjustments, 25
resources, 79–80
actual values
  collecting from resources, 325–326
  manually entering, 326
allocations, 256–257
  evaluating, 258, 274
  example of, 257
fully allocated resources, 256
graphing against a timescale, 260
overallocated resources, 256, 258, 259–268, 275–276
Resource Allocation view, 257, 258, 259–260
Resource Usage view, 257, 258–259, 260–261
underallocated resources, 256, 258
assigning to tasks
  checking plans after resource assignments, 112–116, 122–123
  cost resources, 111–112, 121–122
effort-driven scheduling, 105–111
  recurring tasks, 216–217
work resources, 100–105, 117–119
  assignments
  adjusting in Team Planner view, 244–247, 254
  applying contours to assignments (resources), 236–239, 251–252
  breaking relationships, 326
delaying start dates, 235–236, 251
manually editing work per time period, 239
rescheduling incomplete work, 327–328, 332
tracking actual/remaining work in tasks/
  assignments, 315–320, 330–331
tracking timephased work, 321–327, 331–332
cost resources, 90–91
  assigning to tasks, 111–112, 121–122
defined, 79
Lucerne Publishing practice example, 97
costs, reporting, 346–348, 349, 353
documenting, 91–92, 98
equipment resources, 81–82
filtering
  by built-in/custom filters, 294
  by column headings, 292
  highlight filters, 294–295
Lucerne Publishing practice example, 306
grouping, 286, 288–289, 305
leveling overallocated resources, 262–268, 275–276
Lucerne Publishing practice example, configuring
  work resources, 94
material resources, 239–240
  assigning to tasks, 240–241, 242
creating, 241
defined, 79
fixed consumption rates, 241
Lucerne Publishing practice example, 252–253
variable consumption rates, 241
maximum capacity, viewing, 242–244, 253–254
notes, documenting with, 91–92, 98
people resources, 81–82
resource calendars, 86–87
  assigning a different base calendar to a
resource, 90
modifying work days/times, 89–90, 96
specifying exceptions for work resources, 87–88
resource lists, inserting work resources
  into, 81
sorting, 283, 304–305
work resources
  assigning to tasks, 100–105, 117–119
availability, 80, 228–230, 248
configuring, 94
costs, 80, 86
customizing availability, 228–230, 248
defined, 79
deleting, 81
equipment resources, 81–82
shortcut menus (context/right-click menus)

- constraints, 182–188, 204
- creating/applying new base calendars, 191–193
- effort-driven scheduling, 198–199
- interrupting work on tasks, 188–189
- linking tasks (dependencies), 179–182, 203
- Lucerne Publishing practice example, 72
- manually scheduled tasks, 194
- Peak, 196, 198
- rescheduling tasks, 63–64
- seeing task relationships with Task Path,
  176–178, 202
- standard base calendars, 190–191
- summary tasks manually, 219–222, 226
- switching manual/automatic scheduling, 51–53
- task types, 193–196, 197–198, 199, 206–207
- viewing task details with Task Inspector,
  199–200, 207–208
- working time for individual tasks, adjusting,
  190–193, 205
- variance and, 338–341
- Scheduling Styles (Gantt Chart view), 128
- scope of product, 51
- scope of projects, 44, 51
- ScreenTips, 14
- scrolling in, Gantt Chart view, 136
- scrum meetings (Agile project management),
  recording progress from, 483–485, 498–500
- Scrum templates
  - displaying Scrum Template Instructions view, 472
  - switching between views, 472
- security, macros, 409
- segments, splitting tasks into, 190
- rejoining split tasks, 190
- rescheduling second half of a task, 190
- selecting Project data, 426
- semi-flexible constraints, 182–183
  - FNET (Finish No Earlier Than) constraint, 184
  - FNLT (Finish No Later Than) constraint, 184
  - SNLT (Start No Later Than) constraint, 183, 185, 190
- sensitive material in plans, 20
- shapes, adding to reports, 392
- Share page (Backstage view), 19
- SharePoint Task Lists, 9
- sharer plans
  - managing linked plans in resource pools, 455–456
  - unlinking from resource pools, 455
  - updating working times in resource pools, 456
- sharing resource pools across plans, 448–451,
  452–456, 465
- sheet views, 24–25
- shortcut menus (context/right-click menus), 15

saving
- baselines (plans), 155–158
- clearing previously saved baselines, 158
- Lucerne Publishing practice example, 168
- files in other formats in Project, 431–435, 443–444
- as PDF, 9
- plans, 21, 39
- as XPS, 9
- scheduled (current) costs, 268
- scheduled tasks (manually), 8

scheduling
- effort-driven scheduling, 105–111
- changing schedule results when removing
  resources from tasks, 111, 120–121
- managing for specific tasks, 111
- incomplete work, rescheduling, 327–328, 332
- interrupting work on tasks, Lucerne Publishing
  practice example, 204–205
- start dates (plans), 38, 39, 45
- tasks
  - assignment units, 196
  - change highlighting, 175

ribbon interface, 8, 14
commands, 17
Task tab, 17
touch input and, 17
customizing, 8, 414, 416–417, 421–422
Design tab, 16
expanding/collapsing, 16
File tab, 16, 18
Format tab, 16
Layout tab, 16
Project tab, 16
Report tab, 16
Resource tab, 16
split buttons, 17
tabs, 16
Task tab, 16, 17
tool tabs, 16
View tab, 16
right-click menus. See shortcut menus

S

S

inserting into resource lists, 81
Lucerne Publishing practice example, 94–98
Max. Units field, 82–83, 95
maximum capacity, 82–83, 95
naming, 80–81
pay rates, 83–85, 95–96, 230–232,
233–234, 249–250
people resources, 81–82
resource calendars, 86–90
shortcut menus (context/right-click menus)

saving
- baselines (plans), 155–158
- clearing previously saved baselines, 158
- Lucerne Publishing practice example, 168
- files in other formats in Project, 431–435, 443–444
- as PDF, 9
- plans, 21, 39
- as XPS, 9
- scheduled (current) costs, 268
- scheduled tasks (manually), 8

scheduling
- effort-driven scheduling, 105–111
- changing schedule results when removing
  resources from tasks, 111, 120–121
- managing for specific tasks, 111
- incomplete work, rescheduling, 327–328, 332
- interrupting work on tasks, Lucerne Publishing
  practice example, 204–205
- start dates (plans), 38, 39, 45
- tasks
  - assignment units, 196
  - change highlighting, 175
shortcuts (views), 15
Skype, Project integration, 7
slack/float, 217–218
changing slack threshold, 219
displaying slack for noncritical tasks, 219
slipping tasks and variance, 338–341, 351
Slipping Tasks reports and variance, 340–341
SNET (Start No Earlier Than) constraint, 183, 185, 190
SNLT (Start No Later Than) constraint, 183
sorting
plan details, 280–284, 304–305
resetting sorted lists, 284
resources, 283, 304–305
tasks, 283, 304–305
split (combination) view, 22
displaying, 28
primary/secondary views, 26
reports, 30–31
Task Form, 26
split buttons, ribbon interface, 17
splitting tasks into segments, 190
rejoining split tasks, 190
rescheduling second half of a task, 190
sprints (Agile project management), 478
generating reports, 486–488, 500–501
planning, 479–483, 495–498
standard base calendars, 190–191
Standard calendars (plans), 40
start dates
plans
changing, 39
scheduling, 38, 39, 45
resource assignment start dates, delaying, 235–236, 251
Start screen, creating plans, 11–13
start-to-finish relationships (SF), 63, 179
start-to-start relationships (SS), 62, 179
Statistics dialog, checking finish dates (plans), 67–68
status bar, 14
status reports and project management, 337–338
“status-at-a-glance” snapshots and variance, 334–335
successor tasks, 62–64, 65–66
lag time, 180, 181, 182
predecessor tasks, 180–181, 182
summary tasks, 59–60
demoting tasks, 61
linking, 66
outlining plans with summary tasks, 74–75
promoting tasks, 60–61
scheduling manually, 219–222, 226
task lists, inserting summary tasks into, 61
switching
tables in views, 27
tasks, switching automatically
scheduled tasks/manually scheduled tasks, 72
views, 27, 472
T
Table Tools Design tab (reports), 30
Table Tools Layout tab (reports), 30
tables
% Complete column, progress tracking, 162
columns, adding, 298–299
Cost tables
displaying, 270, 345
reporting resource costs, 347–348, 349
creating, 295–299, 307–308
custom fields, creating, 296–297
reports, 28–29
adding tables to reports, 392
applying styles to tables, 139
customizing tables in reports, 396–398
switching, in views, 27
Variance tables
displaying, 341
displaying scheduled/baselines values, 158
tabular data, copying/pasting
from another program into Project, 427
Paste Special feature, 425
from Project to another program, 424–427, 440
Task Cost Overview reports, 343, 345
Task Form view, 26
assigning resources to tasks, 102–104, 105, 118
effort-driven scheduling, 106–107
Task Inspector, viewing task details, 199–200, 207–208
Task Mapping, opening files in other formats in Project, 429–431, 441–443
Task Path, 7
formatting, 178
seeing task relationships with Task Path, 176–178, 202
Task Sheet view, displaying Cost tables, 345
Task Summary Name field, 6
Task tab (ribbon interface), 16, 17
Task Usage view, 25
actual/remaining work in tasks/assignments, tracking, 317, 330–331
assignments, applying contours to assignments (resources), 236–239
timephased work, progress tracking, 326
tasks, 49
actual/remaining work, tracking, 315–320, 330–331
assigning resources to tasks
checking plans after resource assignments, 112–116, 122–123
cost resources, 111–112, 121–122
effort-driven scheduling, 105–111
work resources, 100–105, 117–119
assignments (resources), breaking relationships, 326
automatically scheduled tasks, 50
durations, 55, 57–58
rescheduling, 63
switching to manually scheduled tasks, 51–53, 72
constraints, scheduling tasks with, 182, 204
ALAP constraint, 183
applying constraints, 186–188
ASAP constraint, 183, 184–185
flexible constraints, 182, 183, 184–185
FNET constraint, 184
FNLT constraint, 184
inflexible constraints, 183, 184
MFO constraint, 184
MSO constraint, 184, 185–186
removing constraints, 188
semi-flexible constraints, 182–184
SNET constraint, 183, 185, 190
SNLT constraint, 183
costs
manually entering actual costs, 319–320
reports, 342–349, 352
creating, Lucerne Publishing practice example, 71
deadline dates, 209–211
Lucerne Publishing practice example, 223
removing, 211
setting, 211, 223
deleting, 51
dependencies, 61–62, 64–65
cross-plan links, 460–464, 466–467
finish-to-finish relationships (FF), 63
finish-to-start relationships (FS), 62, 63
linking tasks, 75–76
start-to-finish relationships (SF), 63
start-to-start relationships (SS), 62
summary tasks, 66
unlinking tasks, 66
documenting, 68–70
adding hyperlinks to tasks, 69
adding notes to tasks, 69
Lucerne Publishing practice example, 77–78
removing formatting from tasks, 70
removing hyperlinks from tasks, 70
removing notes from tasks, 70
durations, 53–54, 58
8/80 rule, 56–57
abbreviations, 55
accuracy in, 56–57
automatically scheduled tasks, 55, 57–58
checking, 66–68, 76–77
elapsed durations, 56
example of, 54
Lucerne Publishing practice example, 73
manually scheduled tasks, 55, 57–58, 63
milestones, 58–59
nonworking days, 55, 58
filtering
by built-in/custom filters, 294
by column headings, 292
highlight filters, 294–295
Lucerne Publishing practice example, 306
formatting
removing formatting from tasks, 70
in Timeline view, 135–136
free slack, 217–218
grouping, 286, 288–289, 305
hyperlinks
adding hyperlinks to tasks, 69
Lucerne Publishing practice example, 77–78
removing hyperlinks from tasks, 70
ID numbers, 49
inactive tasks, 272–273, 278
incomplete work, rescheduling, 327–328, 332
interrupting work on tasks, 188–189, 204–205
Late Tasks reports, variance, examining, 340, 341
linking tasks (dependencies), 5, 61–62, 64–65, 179–182, 460–464
finish-to-finish relationships (FF), 63
finish-to-start relationships (FS), 62, 63
Lucerne Publishing practice example, 75–76, 203, 466–467
start-to-finish relationships (SF), 63
start-to-start relationships (SS), 62
summary tasks, 66
unlinking tasks, 66
manually scheduled tasks, 50
durations, 55
switching to automatically scheduled tasks, 51–53, 72
material resources, assigning to tasks, 240–241, 242
milestones, 58–59, 74
naming, 50
notes
adding notes to tasks, 69
Lucerne Publishing practice example, 77–78
removing notes from tasks, 70
predecessor tasks, 62–64, 65–66
lag time, 180, 181, 182
lead time, 180–181, 182
progress tracking
actual values, 163–165, 166, 170–172
completion percentages, 160–163, 169–170
project summary tasks, displaying in consolidated plans, 460
promoting tasks (outlining plans), 60–61
recurring tasks, 213–216
assigning resources to tasks, 216–217
creating, 216
Lucerne Publishing practice example, 224–225
relationships, 61–62, 64–65
appearances of, 64
changing type of, 181
finish-to-finish relationships (FF), 63, 179
finish-to-start relationships (FS), 62, 63, 179, 180
lag time, 180, 181, 182
lead time, 180–181, 182
linking tasks (dependencies), 179–182, 203
seeing task relationships with Task Path, 176–178, 202
start-to-finish relationships (SF), 63, 179
start-to-start relationships (SS), 62, 179
summary tasks, 66
unlinking tasks, 66
rescheduling tasks, 63–64, 190
resources
assigning to recurring tasks, 216–217
material resources, 239–242
scheduling
assignment units, 196
change highlighting, 175
constraints, 182–188, 204
creating/applying new base calendars, 191–193
effort-driven scheduling, 198–199
interrupting work on tasks, 188–189, 204–205
linking tasks (dependencies), 179–182, 203
Lucerne Publishing practice example, 72
manually scheduled tasks, 194
Peak, 196, 198
rescheduling tasks, 63–64
seeing task relationships with Task Path, 176–178, 202
standard base calendars, 190–191
summary tasks manually, 219–222, 226
switching manual/automatic scheduling, 51–53
task types, 193–196, 197–198, 199, 206–207
viewing task details with Task Inspector, 199–200, 207–208
working time for individual tasks, adjusting, 190–193, 205
slack/float
changing slack threshold, 219
displaying slack for noncritical tasks, 219
slipping tasks and variance, 338–341, 351
Slipping Tasks reports and variance, 340–341
sorting tasks, 283, 304–305
splitting into segments, 190
rejoining split tasks, 190
rescheduling second half of a task, 190
standard base calendars, 190–191
successor tasks, 62–64, 65–66
lag time, 180, 181, 182
lead time, 180–181, 182
summary tasks, 59–60
demoting tasks, 61
inserting summary tasks into, 61
linking, 66
outlining plans with summary tasks, 74–75
promoting tasks, 60–61
scheduling manually, 219–222, 226
task lists
developing, 51
inserting summary tasks into, 61
inserting tasks into, 50
task types
changing, 194–196, 199
effort-driven scheduling, 198–199
fixed duration task type, 194, 197
fixed unit task type, 194, 197
fixed work task type, 194
Lucerne Publishing practice example, 206–207
Timeline view
adding tasks to, 133–135, 148–149
formatting tasks, 135–136
switching task bars to callouts, 135–136
timephased work, progress tracking, 321–327, 331–332
unlinking tasks, 66
viewing task details with Task Inspector, 199–200, 207–208
working time for individual tasks, adjusting, 190–193, 205
Team Planner view, 9
Agile project management, 480, 484
resource assignments, adjusting, 244–247, 254
Tell Me, 7, 13
templates
Agile project management templates
childhood behavior and, 476
navigating, 470–472, 490–491
resetting, 472–475, 490–491
creating, from existing plans, 21–22
global templates, 403–404
copying elements of, 404–405, 406–407
customizing, 404, 406–407, 418–419
elements of, 404
pinning to New page (Backstage view), 19–20
plans
creating from templates, 21
creating from templates/other plans, 20
product backlogs
assigning/unassigning work items, 481–482
updating, 483
Scrum templates
displaying Scrum Template Instructions view, 472
switching between views, 472
sensitive material, 20
sources of, 20
viewing offline, 20
text, formatting in Gantt Chart view, 131–133
text boxes, adding to reports, 392
themes, 7
Timeline view, 5, 6, 8, 22–23
callouts, switching task bars to, 135–136
copying, 140, 141–142
displaying/hiding, 28
finish dates (plans), checking, 67
formatting, 24, 364–367, 381
Gantt charts, panning/zooming, 136–137
multiple timeline bars in, 23
task bars, switching to callouts, 135–136
tasks
adding to Timeline view, 133–135, 148–149
formatting tasks, 135–136
timephased work, progress tracking, 321–327, 331–332
timescale adjustments
Gantt Chart view, 133, 137
resource allocation, graphing against a timescale, 260
in views, 25, 27
tool tabs (ribbon interface), 16
top-down planning, 60
touch input, commands and, 17
Tracking Gantt view
baselines (plans), comparing, 312–313, 314
displaying, 341
schedule variance, 338–341
tracking progress, 154
actual/remaining work in tasks/assignments, tracking, 315–320, 330–331
actuals and, 153
baselines
clearing previously saved baselines, 158
comparing, 312–313, 314
displaying Gantt bar baselines in Gantt Chart view, 158
displaying values with Variance tables, 158
removing, 315
saving, 155–158
updating, 312–315, 326–330
incomplete work, rescheduling, 327–328
interim plans, 313–314, 315
plans, tracking plans as scheduled, 158–160, 169
resource costs, reporting, 346–348, 349, 353
task costs, reporting, 352
Budget Cost visual reports, 344–345, 346
Cash Flow reports, 344, 345
Resource Cost Overview reports, 348, 349
Task Cost Overview reports, 343, 345
tasks
actual values, 163–165, 166, 170–172
completion percentages, 160–163, 169–170
timephased work, 321–327, 331–332
variance, 334
defined, 311
displaying Variance tables, 341
Late Tasks reports, 340, 341
reporting, 334–337, 350
slipping tasks, 338–341, 351
Slipping Tasks reports, 340–341
underallocated resources, 256, 258
unlinking tasks, 66
updating
baselines (plans), 312–315, 326–330
product backlogs, Agile project management, 483
read-only resource pools, 455
sharer plans, updating working times in resource pools, 456
usage views
Resource usage view, 25
Task Usage view, 25
user interface
active view (report), 14
commands, 14
Feedback smiley button, 13
Groups, 14
Quick Access Toolbar, 13
ribbon interface, 14
commands, 17
expanding/collapsing, 16
split buttons, 17
tabs, 16–17
user interface

ScreenTips, 14
shortcut menus (context/right-click menus), 15
Start screen, creating plans, 11–13
status bar, 14
Tell Me, 13
view label (report label), 14
view shortcuts, 15
Zoom Slider, 15

V
variable consumption rates, material resources, 241
variance, 334
defined, 311
reporting
  Burndown reports, 336–337
  Cost Overview reports, 336
  Late Tasks reports, 340, 341
  Lucerne Publishing practice example, 350
  Project Dashboard reports, 335–337
  Project Statistics dialog, 334–335
  Slipping Tasks reports, 340–341
  status reports, 337–338
  ‘status-at-a-glance’ snapshots, 334–335
schedule variance, 338–341
slipping tasks, 338–341, 351
Variance tables
displaying, 341
displaying scheduled/baselines values, 158
VBA macros
deleting, 410
editing, 410–412, 420–421
recording, 407–409, 419–420
running, 410, 419–420
security, 409
view label (report label), 14
view shortcuts, 15
View tab (ribbon interface), 16
viewing
critical paths, 217–219, 225
essential cost/schedule values, 269
maximum capacity of resources, 242–244, 253–254
resource pool usage details, 455
task details with Task Inspector, 199–200, 207–208
views, 22
active view (report), 14
Backstage view, 8, 16, 18
Account page, 19
creating plans as blank projects, 21
creating plans from templates/other plans, 21
creating templates from existing plans, 21–22
exiting, 20
Export page, 19
Info page, 18–19
New page, 19, 21
Open page, 19
opening plans, 21
options, 18
Print page, 19
Project integration, 7
Project Options dialog, 19
saving plans, 21
Share page, 19
Calendar view, formatting, 372–374, 383–384
copying, 140–142, 150–151
creating, 299–303, 308–310
customizing, 377, 384
exporting as PDF or XPS file, 377–378, 384
Gantt Chart view, 22–23
  assigning resources to tasks, 101, 102, 103–104, 118, 119, 121
  checking finish dates (plans), 67–68
  copying, 150
  customizing, 126–129, 130, 146–148
  displaying Gantt bar baselines in Gantt Chart view, 158
drawing on Gantt charts, 129–130
elements of, 126–127
formatting, 131–133, 358–364, 379–380
Presentation Styles, 128
printing, 143–144, 151
progress tracking with Gantt bar, 162–163
relationships, 64–65
resolving overallocated resources manually, 261
Scheduling Styles, 128
scrolling in, 136
timescale adjustments, 133, 137
Gantt with Timeline view, 22, 23, 126
Levelling Gantt view
  overallocated resources, 266–268
  resource allocation, 258
Network Diagram view, formatting, 368–371, 382–383
printing, 142–144, 151–152, 374–377, 384
reports versus views, 390–391
Resource Allocation view, 257, 258, 259–260
Resource sheet view, 24–25
Resource Usage view, 25, 257, 258–259
applying contours to assignments, 236–239
overallocated resources, 260–261
resource costs, reporting, 347–348
timephased work, tracking, 327
timescale adjustments, 25
Scrum templates
displaying Scrum Template Instructions view, 472
switching between views, 472
sheet views, Resource sheet view, 24–25
split (combination) view, 22
switching, 27
Task Form view, 26
assigning resources to tasks, 102–104, 105, 118
effort-driven scheduling, 106–107
Task Sheet view, displaying Cost tables, 345
Task Usage view, 25
applying contours to assignments, 236–239
timephased work, tracking, 326
tracking actual/remaining work in tasks/assignments, 317, 330–331
Team Planner view, 9
adjusting resource assignments, 244–247, 254
Agile project management, 480, 484
Timeline view, 5, 6, 8, 22–23
adding tasks to, 133–135, 148–149
checking finish dates (plans), 67
copying, 140, 141–142
displaying/hiding, 28
formatting, 24, 364–367, 381
formatting tasks, 135–136
multiple timeline bars in, 23
panning/zooming Gantt charts, 136–137
switching task bars to callouts, 135–136
timescale adjustments, 27
Tracking Gantt view
comparing baselines (plans), 312–313
displaying, 341
usage views
Resource usage view, 25
Task Usage view, 25
Visio, generating reports in, 435–438, 444–445
visual reports, generating in Excel or Visio, 435–438, 444–445

W
Word, copying/pasting to, 8
work packages. See tasks
work resources
assigning to tasks, 100–105, 117–119
availability, 80, 228–230, 248
configuring, 94
costs, 80, 86
defined, 79
deleting, 81
equipment resources, 81–82
Max. Units field, 82–83, 95
maximum capacity, 82–83, 95
naming, 80–81
pay rates, 83–85
changing pay rates over different date ranges, 233–234, 250
Lucerne Publishing practice example, 95–96
multiple resource pay rates, 230–232, 249–250
people resources, 81–82
resource calendars, 86–87
assigning a different base calendar to a resource, 90
modifying work days/times, 89–90, 96
specifying exceptions for work resources, 87–88
resource lists, inserting into, 81
work weeks, customizing in calendars, 42–43
working times
individual tasks, adjusting in, 190–193, 205
sharer plans, updating in resource pools, 456

X-Y-Z
XPS files
exporting views as, 377–378, 384
saving files as XPS, 9
Zoom Slider, 15, 25, 27
zooming/panning, Gantt charts in Timeline view, 136–137